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Introduction and Safety

1.0 Support

1.1 Safety & Warnings

For Muse support, please go to 

https://techsupport.signwarehouse.com/muse-vinyl-cutter-support-resources/

Please read the following safety guidelines regarding use of your Muse cutter:

Symbols inside triangles represent important notes that warrant your full attention. There are 

di�erent symbols denoting speci�c warnings. The symbol at left, for example, warns of a 

possible danger of electric shock.

The cross-bar indicates activities that are prohibited because of risk of injury or possible 

damage to your equipment. This particular symbol at left warns against the use of tools to 

remove parts of the equipment.

Don't use with an electrical power source which doesn't meet the required voltage rating.  

Using with substandard sources of electricity may result in �re or electric shock.

Don't use your Muse if it begins to emit an odor or smoke.

Don't un-plug your Muse while powered on. Doing so may damage the equipment.

Make sure your Muse is grounded. Using your Muse without it being grounded may result in risk 
of equipment damage or electric shock.
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Thank you for choosing a Muse vinyl cutter.



Don't disassemble your Muse or attempt repairs unless directed by 

SignWarehouse technical support.

Don't drop any liquids or metal objects into your Muse. Liquids or impact from hard 

or heavy objects may damage the equipment.

Touching your Muse’s blade with your �nger may result in injury.

Don't damage or replace the power cable supplied with the vinyl cutter. Don't 

excessively bend, pull, or fold the power cable or place weight on it.  Crimping 

the power cable may result in risk of failure or electric shock.

If you're not going to use your Muse for a long time, unplug the power 

cable from the outlet.

Placing your hands on the cutting platen during operation may result in injury.

Place your cutter on a stable surface. Operating the vinyl cutter on an  

unstable surface may result in a fall that can damage the equipment or 

internal components.

To unplug the power cable from a receptacle, always grasp the plug 

instead of the cable. Pulling the cable may damage it and increase 

the risk of �re or electric shock.

Don't operate during an electrical storm where lightning is present. For protection 

against power surges, a surge protector is recommended.

Don't physically move the cutting head while your Muse is powered on. Manually 

moving the cutting head during operation may damage the main board.
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1.3 Warranty

1.4 Muse Contents & Accessories

The Muse cutter comes with a one-year parts warranty. If you have any questions about your cutter’s  warranty, 

please contact SIGNWarehouse via our warranty claim form at techsupport.signwarehouse.com.

It is recommended that you keep your original box with the Styrofoam packing materials in case your  Muse 

must be shipped or returned to SIGNWarehouse. 

Besides the cutter, your box should also contain the following items:

Accessories Box containing all of the 
following except for the Cutting Mat

Power Adaptor

M15 M24 M60

Power Cable

USB Cable (white or blue)

30° Blade

45° Blade

60° Blade

Blade Holder

Test Pen

Engraving Tool

Creasing Tool

Cutting Mat
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1.5 Parts of the Muse Cutter

 Parts of the Muse 15 and 241.5.1
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 Parts of the Muse 601.5.2
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1.6 Accessories

1.7 Pinch Rollers

The test pen is used in calibrating the Muse’s camera (Section 3.01), 

calibrating the Scale (Section 2.07), and is also recommended for test 

drawing while you are learning where shapes will cut based on various 

software settings. Note that a small piece of wax needs to be removed from 

the pen’s nib before use. You may also wish to cut o� the very top of the pen 

re�ll so that it more easily �ts into your Muse:

Your Muse is designed for cutting rolls and sheets of adhesive-backed �lms such as vinyl, stencil mask and 

sandblast etching �lms. It can also use the included cutting mat for non-backed materials such as paper, 

cardstock, magnet sheets and Mylar.

Press down the lever on the back of your M15 or M24 to raise the pinch rollers. On the M60 model, there are 

individual levers on each pinch wheel which are lifted instead.

Insert the media into the space between the pinch roller and grit roller and pull out the media far enough to 

ensure that it is loaded straight. The edges of the vinyl should be parallel to the left and the right frame of the 

cutting platen. (A ‘platen’ is the lower plate that supports the vinyl as it passes through the cutter.)

The 30° yellow capped blade (not shown) is well-suited for window 

tint and fabric. It is included with the M60.

The 45° red capped blade is well-suited for cutting thinner materials such as heat transfer vinyl and 

wall/auto/decal vinyl. Two of these are included with the Muse.

The 60° blue capped blade has a longer cutting edge and is well-suited for cutting thicker materials like 

sandblast stencil, �ock, craft foam, magnet sheets, light chipboard, rhinestone template materials, etc. It 

is included with the M15 and the M24.

Installing the blades into the blade holder is covered in Section 2.01. Blade O�set is covered in Section 

2.02.2.

1.

2.

3.

 Test Pen1.6.1

 Muse Blades1.6.2

There are two kinds of blades that came with your Muse (note that which two 

kinds di�er depending on the model you purchased).



1.8 Control Panel

When you �rst power on the Muse, the following Main Screen 

or Home Screen will be displayed after several seconds:

The functions of the buttons on this Main Screen are:

SET: Opens the SETTING menu with access to other functions, 

such as CAMERA, WI-FI, ARRAY, ADVANCED SETTINGS, etc. 

See Section 1.8.1.

RECUT: Recuts the last job which is stored in the Muse’s memory. Note that while the Muse is cutting, this 

button will read PAUSE. Pressing it will pause the cutting process in case any changes need to be made. 

Pressing again will resume the cut.

UDISK: Opens the UDISK window allowing access to �les on a USB thumb drive plugged into the Muse’s USB 

Flash Drive port. Files must be saved in .PLT format to appear in the menu (See Sections 1.10.6 – 1.10.8 for 

details).

STOP: One-touch emergency stop button stops the cutter and cancels the cut.

SPD/FOR: This button opens the SPEED/FORCE screen where you can optionally set the cutting speeds and 

force of the cutter, as well as access the stored presets (See Sections 2.2-2.5).

TEST: Press the TEST button to cut a small square. This is recommended to ensure a clean cut is achieved with 

the current settings before proceeding with a cut job.

Slide the pinch roller assemblies left and right so that the pinch rollers are centered over the grit roller. 

The positions of the exposed grit rollers in the platen are marked by white arrows above the platen. 

You may raise the cover above the tool carriage to see the arrows more clearly. Be sure to close it 

before cutting.

Once the pinch rollers are in position, lower them to keep 

your media in place. When using the cutting mat, you 

need at least two wheels near the outside edges of the 

mat, thus center the mat inside the cutter (versus having it 

all the way to one side).

Each pinch roller on the M15 and M24 has a little lever on 

the back side. These levers adjust the amount of pressure 

applied to the media. Increasing the pressure can help 

with slicker or thinner media such as heat transfer �lm. It 

may be advisable to reduce the pressure to accommodate 

thicker materials like glass etch stencil. For normal use, like heat 

transfer vinyl and sign vinyl, keep the levers in the higher position:

Fig. 1.8.1



Arrows: The left-right arrows move the tool carriage while the up-down arrows move the grit rollers. 

This allows you to start cutting anywhere on the media (i.e. set an origin).

Double Arrow: The double arrow button controls the speed of the tool carriage and grit rollers while 

setting a new origin. The default setting is the faster mode. Pressing this button once will change the 

color of the button from blue to red, which indicates the slower mode. This mode can be used for very 

precise movement.

 Setting Menu1.8.1

The Setting menu provides access to seven additional 

screens on two di�erent pages:

These various functions and settings are:v

TO START: return the blade holder to the origin (the location immediately before the cut was started

TO END: advance the blade holder to the top of the completed cut with the option to move an additional 

distance

To LEFT: advance the blade holder to the left of the completed cut with the option to move an additional 

distance

ARRAY: Set up rows and columns of repeats with desired spacing (refer to Section 1.8.4)

ADVANCE SETTINGS: Refer to Section 1.8.3.

GENERAL SETTINGS: Refer to Section 1.8.2.

SYSTEM INFORMATION: Hardware and �rmware versions, Baud rate, and other settings that should need no 

adjustment unless directed by a SignWarehouse technical representative.

 General Settings1.8.2

Press SET on the Muse control panel and select GENERAL 

SETTINGS. The optional settings are:

CAMERA: Opens the CAMERA SETTINGS menu. 

Refer to Section 3.00.

WIFI: Connect the MUSE to your home or o�ce router for 

wireless connectivity (refer to Sections 1.10.4 and 1.10.5).

ADVANCE MODE: Three options for where the blade holder goes at the end of a cut:

Fig. 1.8.2

Fig. 1.8.3



LED: This option allows you to customize the platen lighting in your Muse.

On the M15 and M24, the default color is a cool blue. But if blue isn’t your cup of tea, you can change on this 

screen. There are slider bars to help pick a custom color. You can also turn o� the LED platen lighting if you 

wish. Note: In case of an error during cutting, the LED platen lighting will immediately turn red to indicate an 

alarm condition.

          On the M60, you can change the intensity of the white light according to your personal preference.

.

 Advanced Settings1.8.3

Press SET on the Main Screen and select ADVANCE

SETTINGS. The optional settings are:

SHOW POINT: This feature shows the origin point 

of your cut jobs. When toggled on, the Main Screen 

will display an updated center button used to reset 

the origin, as well as some location positions:

Absolute Location displays the current location relative 

to the “power-on” origin point of (0,0):

!

X is the position relative to the movement of the 

cutter’s tool carriage from left to right across the 

platen.

Y is the position relative to the forward and 

backward motion of the media as it is fed by the 

grit rollers.

L is the straight-line distance from X to Y.

ALARM: Enabling ALARM AFTER COMPLETED will produce an audible alarm of 5 beeps once a job completes. 

Uncheck this box if you wish to turn o� this feature. Similarly, enabling LED AFTER JOB COMPLETED will change 

the LED color to blue once a job completes. 

This feature is only on the M15 and M24 models.

SCREENSAVER: After a predetermined period of time, the cutter goes into standby mode to save energy and the 

LCD screen will darken as the cutter goes to sleep. You can change the amount of time before sleep mode 

begins.

UNIT: This setting allows you to choose the unit of measurement for all functions involving distance, such as the 

spacing between repeats or position of the cutting head. The default setting is MILLIMETERS (mm). The other 

option is INCHES (in). Because the SPEED and FORCE settings on a Muse are based on a scale versus units, they 

remain the same whether you are in imperial mode or metric.

LANGUAGE: This screen o�ers a choice of three languages: English, Spanish, and Mandarin. You can choose one 

of these for the language in which all settings and menu communication are displayed

Fig. 1.8.4

Fig. 1.8.5



Relative location displays a new location relative to the last origin you set. This will match the Absolute 

Location until you press the origin set button:

 Array Setup1.8.4

This feature allows you to convert one cut job into multiple 

copies and arrange them in rows and columns.

Tap the ARRAY button to open the ARRAY SETTINGS screen:

In FIG 1.8.6, the �le sent to the Muse would be cut in a 

pattern or array of eighteen copies, arranged in six rows and 

three columns. The spacing between each row is set to 1” 

and the spacing between each column is set to 0.5”. Note 

that the units can be changed to metric, if desired (refer to 

Section 1.8.2).

Y KEY MODE: This setting controls how the Muse cutter moves your media forward or backward (along 

the Y axis), as you press the up/down arrow keys on the control panel.

GO RIGHT WHEN POWER ON:  When this setting is enabled, the tool 

carriage will move to the right side of the cutter when the cutter is 

powered on. Otherwise, the tool carriage remains in its current position.

SYSTEM MODE: This screen is only needed for the M60 model in which 

you can activate both heads to be used. Once the DOUBLE option is 

selected, the Main Screen will update so that you can elect to use the 

left side, right side, or both:

SCALE: This setting is used to input the sizing calibration. Refer to Section 2.7.

x is the current left-to-right distance moved from the last origin (how far you have moved the tool 

carriage across the platen).

y is the current up-&-down distance moved from the last origin (how far you have moved the media 

forward or backward in the Muse).

l is the straight-line distance relative to the last origin.

In the DEFAULT setting, pressing the up arrow moves the media forward and pressing the down arrow 

moves it backwards.

Setting the Y KEY MODE to INVERSE will �ip this so that pressing the up arrow will move the media 

backwards.

Use the ARRAY feature to 
set up repeats of a design 
sent to the Muse

Fig. 1.8.6

Fig. 1.8.7

Blade holder at right
edge of platen



Depending on which software you purchased with your Muse vinyl cutter, 

there are two ways to set it up:

1.

2.

Place your Muse on a sturdy horizontal surface. Keep the area around the Muse free of clutter and 

unnecessary items. This will prevent other objects from obstructing normal feeding of media through the 

cutter. Impacts with items around the cutter can cause a material to lift o� the platen or feed incorrectly. 

Either of these can negatively impact cut quality and/or tracking.

To turn on the power for the M15 or M24, press the power button on the right end cap. For the M60, 

�ip the switch up on the left end cap.

The Muse will take a few seconds to power up. The LED light will come on and the tool carriage will engage. 

REMEMBER: Once the cutter is on, do not move the tool carriage manually. This can damage 

the tool carriage and/or main board. Use only the arrows on the control panel to move the tool carriage.

To power o� your M15 or M24 cutter, press and hold the power button until the cutter powers down. On the 

M60, �ip the power switch down.

There are 3 ways that you can connect your Muse to the computer:

You may choose any one of these three connectivity options. You can also change from one to the other at 

will, but for best results use one at a time. Here are the bene�ts of each connectivity option:

You’ll �nd complete step-by-step instructions on our Product Support 

Blog for LXi. Please click here to access the setup tutorial or go to 

https://techsupport.signwarehouse.com/

To install Create Space, download the software from the following 

link (note there are separate links for Mac and Windows users). You 

will also �nd a video to assist you with installation and activation of 

your registration number: 

https://techsupport.signwarehouse.com/create-space-software-support-resources/

1.

2.

3.

1.

USB Cable

Wi-Fi

USB Flash Drive

The USB cable is the simplest and most reliable connection. Setup is quick and easy. See Sections 1.10.1 
or 1.10.2 for instructions.

1.9 Registering and Installing the Design Software

1.10 Connecting the Muse to Your Computer



 USB Connection in LXi1.10.1

Turn on the Muse before connecting to your computer. Using the USB cable that came with the cutter, plug 

the wider end into your computer’s USB port and the squarish end into the cutter’s USB port which is on the 

right end cap (see FIG. 1.5.4).

Open LXi Production Manager. If this is your �rst time opening LXi, a popup screen will request a Brand and 

Model selection. Otherwise, select Setup and from the drop-down menu, click Add Setup.

From the pop-up window, choose MUSE as the Brand. Find and select M15, M24 or M60 in the Model 

window:

Click Next. The setup window will ask how your Muse is connected to the computer. Open the drop-down 

menu and select the largest available option for USB_Printer_X where X will be 0, 1, 2, etc. For example, if you 

see both USB_Printer_0 and USB_Printer_1 then you would select USB_Printer_1 because it is the higher of 

the two. It is not recommended that you select USB001 or USB002 (or other) from that menu. They may work 

for basic functions but may not adequately support contour cutting.

Click on Finish at the bottom of the Add Setup window.

2.

3.

Wi-Fi takes a little more time and care to set up but o�ers a wireless environment in which the cutter 

can be used without being connected to the computer on which the software is installed. See Section 
1.10.3 and Section 1.10.4 or 1.10.5 for detailed instructions.

The USB �ash drive option allows you to use the cutter without being connected to the PC. Files can be 

saved from the design station computer in .PLT format and transferred to the cutter using a USB thumb 

drive. See Sections 1.10.6 - 1.10.8.

Fig. 1.10.1

Fig. 1.10.2



Turn on the Muse before connecting to your computer. Using the USB cable that came with the cutter, plug 

the wider end into your computer’s USB port, and the squarish end into the cutter’s USB port which is on the 

right end cap (see FIG. 1.5.4).

Open Create Space and select New Project.

Go to Cutter>My Cutter>Manage Cutters and a new window will open (FIG. 1.10.3).

A new window will open. On the right side, under Company/Brand select MUSE and under Model select M. 

Click Add to list. Click Done to apply and close the window.

Once you are ready to cut, click the Cutter icon on the Toolbar at the top of the screen. The Cut Settings 

window will open and, in the Connection drop-down menu, select USB. You can change the port or leave it 

on Auto Detect. If you click on Test Connection, it should move the blade carriage back and forth one time. 

This does not send a cut, just a signal to the cutter.

 USB Connection in Create Space1.10.2

For initial setup using the Wi-Fi option, you may need to place the Muse in the same room or in close 

proximity to the Wi-Fi router. This will create a stronger connection and faster Wi-� network con�guration. 

Once the connection is set, you can move the cutter around within the limits of your router’s coverage area.

 Connecting the Muse to a Wi-Fi Network1.10.3

Fig. 1.10.3

Fig. 1.10.4



You will need the name of the network and the password.

Carefully complete the following steps:

1.

2.

On the Control Panel, press the SET button to access the SETTING menu:

Press the WIFI icon:

3.

4.

5.

In the next screen, press the SCAN button and a list of wireless networks will appear. Select your network 

and press APPLY.

Press the SET button and enter your network password. Press OK.

An IP address (IP ADDR) will appear. The �rst three sets of values will be obtained from your network. Use 

the + or – buttons to set the last digits of the IP ADDR that you wish to use:

Fig. 1.10.5

Fig. 1.10.6

Fig. 1.10.7



6.

7.

8.

9.

10.

11.

Press APPLY to set the changes and add the Muse to your wireless network. This can take up to a minute or 

longer.

Note the complete IP address at the top of the window (FIG. 1.10.7). You will be entering this same IP 

address in the software you use for cutting.

If you need to reset or change networks, press and hold the DEFAULT button for 3 seconds. This will reset 

the settings and enable you to change the network.

Before connecting the Muse to your computer using a Wi-Fi connection, you must verify that your 

computer is also connected to the same network. To do this, locate and launch the network icon for your 

computer:

A menu of available networks will appear. Select the network used for the Muse setup and, if needed, 

enter the network password. Wait a bit for the connection to be made and the menu should indicate 

you are now connected to that network.

Proceed to either the next section (if using LXi Production Manager) or Section 1.10.5 (if using Create 

Space).

On a PC: On a Mac:

If the APPLY button on the Muse WiFi screen changes to CONNECTED OK, you have successfully 

connected!

If the APPLY button changes to PASSWORD ERR, check your settings, and enter the correct values.

Click on the Network icon.

(usually in lower right corner)

Click on the Network icon.

(usually in upper right corner)

If you are connected via

Ethernet, your network icon

may look like this.

 Wi-Fi Connection in LXi1.10.4

Open LXi Production Manager. If this is your �rst time opening LXi, a pop-up screen will request a Brand and 

Model selection. Otherwise, select Setup and from the drop-down menu, click Add Setup.

From the pop-up window, choose MUSE as the Brand. Find and select M15, M24 or M60 in the Model 

window:

Fig. 1.10.8



Click Next. The setup window shown in FIG. 1.10.9 will ask how your Muse is connected to the computer. 

Select TCP/IP. A small window will appear in which you can type in the cutter’s IP Address from Step 7 in 

Section 1.10.3 (FIG. 1.10.7)

Below TCP/ IP address, you will need to enter the 

correct Port number which is 8080. Enter this 

value and click Test. If you have a successful 

connection, LXi will indicate success. Click on OK 

to close the Communication window. Click on 

Finish at the bottom of the Add Setup window.

If Test fails, check the Muse again to verify the 

network name and the IP address. If you change 

settings, it may be necessary to wait a minute 

and start from the beginning of the process in 

order to allow the computer time to reset and 

recognize the Wi-Fi connection.

 Wi-Fi Connection in Create Space1.10.5

Open Create Space and select New Project.

Go to Cutter>My Cutter>Manage Cutters.

A new window will open. On the right side, under Company/Brand select MUSE and under Model select 

M. Click Add to list. Click Done to apply and close the window:

Once you are ready to cut, click the Cutter 

icon on the Toolbar at the top of the 

screen. The Cut Settings window will open 

and, in the Connection drop-down menu, 

select TCP/IP (FIG. 1.10.11)

In the IP �eld, type in the IP Address from 

Step 7 in Section 1.10.3.

Once you type in the IP address, click on 

Test Connection, it will move the blade 

carriage back and forth. This does not 

send a cut, just a signal to the cutter. If not 

connected, you may need to change the 

IP address to a free number on your 

system.

Fig. 1.10.11

Fig. 1.10.9

Fig. 1.10.10

Fig. 1.10.11



 USB Flash Drive Setup in LXi1.10.6

If you are new to LXi, follow the �rst few steps in Section 1.10.1 to add the Muse to LXi Production Manager.

Using the UDISK (USB thumb drive) option involves saving a .PLT �le containing the cut design and some 

or all of the cut settings. This �le can then be opened directly onto the Muse and cut. Remember that with 

this option, once the �le is saved to the thumb drive, the design is locked in and cannot be edited, other 

than setting up an array of repeats.

Once your �le is ready to cut in LXi, insert a USB �ash drive into the design station computer.

Click on OK and LXi Production 

Manager will open.

The Cut/Plot window will also have opened. On the General tab, select SAVE to FILE from the Send 

mode drop-down menu:

When you have made any necessary changes to the �le size, copies, rotation, etc., click the Send button at 

the bottom right of the Cut/Plot window.

A window will open prompting you to select the desired location to save the .PLT �le. Browse to the 

installed �ash drive and save the �le after entering a new name. Go to Section 1.10.8.

Change the Port connection by right clicking on the Muse in the Production Manager list, and 

selected Change Port (as shown in FIG. 1.10.14)

In the Change Port window, select FILE and then complete other options, as preferred:

Go to File>Cut/Plot or click the Cut/Plot 

icon . A window will open and you will 

need to select the location of the LXi 

Production Manager in relation to your 

design station computer:

NOTE: if you will continually be using the USB Flash Drive as your method of sending �les to the Muse:

Fig. 1.10.12

Fig. 1.10.13



If you are new to Create Space, follow the �rst few steps in Section 1.10.2 to add the Muse to Create 

Space.

Using the UDISK (USB thumb drive) option involves saving a .PLT �le containing the cut design and 

some or all of the cut settings. This �le can then be opened directly onto the Muse and cut. Remember 

that with this option, once the �le is saved to the thumb drive, the design is locked in and cannot be 

edited, other than setting up an array of repeats.

In the Cut Settings window, verify you see the design in the Preview as shown in FIG. 1.10.15, and choose 

either Origin Point (move shapes to cut at the origin) or WYSIWYG mode (leave shapes in location on 

virtual mat in main window) depending on which you prefer.

Mark the box for Use Software Speed and Pressure, if you want those included in the �le. Otherwise, leave 

the box unchecked and you can set those values on the Muse’s control panel. The other cut settings 

including Blade O�set, Overcut, and Multi-cut 

(Passes) will always be included in the .PLT �le:

Once your �le is ready to cut, insert a USB �ash drive into the computer. Click on Save to File at the bottom of 

the Cut Settings window. A new window opens where you can browse to �nd the USB �ash drive, name the 

�le, and mark the box for Add registration marks, if this is a contour cutting application.

 USB Flash Drive Setup in Create Space1.10.7

Fig. 1.10.14

Fig. 1.10.15



 Loading and Cutting a .PLT File from the USB Drive1.10.8

Insert the USB �ash drive into your Muse cutter’s USB Flash Drive Port (see FIG. 1.5.4).

On the Main Screen, press the SPD/FOR button and change the FORCE and SPEED settings if you did not 

elect to send them within the .PLT �le (refer to Section 2.02.1). Perform a test cut, if needed.

Press the UDISK icon on the Main Screen. Press OPEN to access the �les on the USB �ash drive. The Muse 

will browse the contents of the installed USB thumb drive and display all readable .PLT �les (Note: If there 

are folders on the drive, you may have to use the touch screen to open the correct folder to �nd the saved 

.PLT �le).

Locate the �le you wish to cut and double tap it. The �le will then be loaded into the U DISK PORT FILES 

screen:

Press START CUT to cut the .PLT �le. Note that if you want to cut repeats refer to the Array function covered 

in Section 10.8.4.

1.11 Maintenance

All Muse cutters are made with high-quality internal lubrication to protect all mechanical components. 

Therefore, there is no need to oil or lubricate any of the components, ever! Daily care consists of cleaning the 

platen and blade holder to prevent buildup of dust and material debris. Dusting the platen with a soft brush 

will get the job done perfectly. Debris inside the blade holder can be removed using a can of compressed air 

and a nozzle. Also, make sure the pinch rollers and grit rollers are kept clean and free of any stickiness.

Fig. 1.10.16



Cutting

2.0 Cutting Overview

To be a successful owner of a vinyl cutter, you need to keep in mind a few factors:

2

You’re going to make mistakes. This is normal and part of the process of mastering a cutter.

Read this chapter. It contains valuable information to help you understand how to load the blade, set the 

exposure, understand the e�ects of various cut settings, create presets, and set a new origin.

Perform test cuts before cutting large projects. It prevents wasted material and preserves your valuable 

time.

2.1 Proper Blade Installation

Before using the Muse advanced control panel to set the cutting speed and force, it is important to make sure 

the blade is installed properly in the blade holder. Remove the protective cap on the blade and follow these 

instructions:

The blade tip only needs to protrude far enough to cut through the face �lm and adhesive of adhesive-backed 

vinyl. This is a combined thickness of approximately 0.005" or less. The blade should not extend farther than ~ 

half the thickness of a credit card.

When properly installed, the tip of the blade is barely visible (See FIG. 2.01.2 below). Adjust the blade inside the 

holder by turning the knob clockwise to extend more of the blade and counterclockwise to retract it.

Fig. 2.1.1



Now that you have inserted the blade properly in the blade-holder, you can use the Muse’s control panel 

and menu options to expertly manage the speed and force of the cutter. Cutting vinyl successfully requires 

managing the amount of force you apply to the material and the speed at which the tool carriage moves 

across the platen.

2.2 Cut Settings

Box Test: To make sure the blade is inserted properly, use the images in FIG. 2.1.1 as a guide. Once the blade is 

installed in the blade-holder, place a sheet of vinyl on a �at surface, and place the blade-holder against the 

vinyl. Try to hold it perfectly perpendicular to the surface (FIG. 2.1.3). Next, move the blade-holder across the 

vinyl and draw a square. Set aside the blade-holder and try to weed the box.

Perfect. The blade cuts 
through the vinyl, but not 

the release liner.

The blade is too far out. It’s 
cutting all the way through 

the release liner.

The blade isn’t out far 
enough to cut through the 

vinyl.

If you cannot remove the box from the rest of the vinyl, you 

may not have cut deeply enough. The blade may need to be 

adjusted so that the tip extends farther.

If the vinyl lifts easily, but the release liner below is deeply 

scored or cut all the way through, the blade is cutting too 

deeply. Adjust it so that less of the tip is showing.

If you can easily weed the box, but the release liner paper 

below is barely scored (or not scored at all), the blade is 

installed correctly in the blade-holder. You are now ready to 

install the blade-holder in the tool carriage and use the 

speed and force settings to optimize cut quality and 

e�ciency. Fig. 2.1.3

Fig. 2.1.2



Force Guidelines: There are di�erent levels of force required for various kinds of self-adhesive vinyl and heat 

transfer vinyl. Generally speaking, thicker or coarser materials such as re�ective vinyl or glitter-�ake HTV require 

more force than standard 3 mil sign vinyl.

The Muse makes managing these settings easier. It allows you to store, edit, and recall saved settings for 

di�erent kinds of materials, so you can quickly change from one type of �lm to another.

The recommended or optimal force varies for di�erent materials. The ideal force setting may even change for 

di�erent colors. White vinyl sometimes requires more cutting force than other colors, due to the density of the 

pigment. It’s always a good idea to perform a test cut before proceeding. This can be done using the TEST 

button on the SPEED/FORCE screen.

Speed Guidelines: In commercial signs and graphics, the faster you get a job done, the better. Time is money 

and speed saves time. So, it’s tempting to run your cutter at top speed all the time, but this is not always the 

best approach.

Think of the cutter making vinyl graphics as if you were drawing, holding a fountain pen, or cutting with a 

hand-held X-Acto knife. If you were cutting or drawing a large square, you could go very quickly. If, however, 

you were cutting an intricate image, you might want to slow down and make sure you got all the curves and 

corners right.

The same holds true for vinyl cutters. You can cut large simple graphics at maximum speed. Cutting small, 

intricately detailed graphics requires more care and should be done at lower cutting speeds.

Just as you would do manually, if you’re cutting something thick or tough, you would slow down to make sure 

you’re cutting with enough force. Likewise, when using your Muse, cut thicker or tougher �lms on a lower 

speed setting to ensure good cut quality.

US and VS Speed Settings: To make your cutter even more e�cient, there are two available speed settings in the 

Muse control panel:

US is the ‘up speed’, the speed of the tool carriage when the blade is lifted o� of the media, moving from the 

origin to the start of the �rst shape to cut, or when moving from one shape to the next.

VS is the ‘down speed’ or the speed of the tool carriage when the blade is in the down position, cutting the 

shapes from the media.

For instance, you may need to use a lower VS to cut a detailed graphic, but you can leave the US at a much higher 

setting. Overall, there will be a time savings compared to use a lower VS for the entire project.

 Force and Speed2.2.1

Changing Speed and Force: To change the speed 

and force settings on your Muse:

From the Main Screen, press the SPD/FOR button 

and the following screen appears:

Fig. 2.2.1



You can change settings by either sliding your �nger across a bar or by pressing the + or – buttons to increase 

or decrease the parameter. The green slider will change to show the Speed or Force selected, relative to the 

minimum and maximum values possible.

Both the Up Speed and Cut Speed are displayed on a scale from 1 to 13:

Force is displayed on a scale from 1 to 160 where 160 represents the maximum of 800g (on the M15 and M24 

models) and 2000g (on the M60 model).

Once you have set the desired speed and force, load some vinyl and press the TEST button. Weed the pattern 

to determine whether the applied force is su�cient to cut through the top layer and adhesive, but not so 

much that it cuts through or deeply scores the release liner.

The Muse has the ability to store up to eight combinations of Speed and Force. Refer to Section 2.03.

The settings from 1 through 4 are the slow speeds and should be used when cutting dense di�cult 

materials.

The settings from 5 through 8 are medium speeds and should be used for easy-to-cut materials, such as 

cardstock, vinyl, iron-on transfer, and rhinestone template material.

The settings from 9 through 13 are the fast speeds and are useful for engraving and drawing. You may, 

however, �nd that some materials will cut well at the faster speeds. You can normally use this higher 

range for the Up Speed.

 Blade O�set2.2.2

Fig. 2.2.2

Fig. 2.2.3



O�set Adjustment: If you are cutting rectangular paths and �nd that paths which should have 90° angles are 

instead rounded, the Blade O�set is too low. If the angles are sharp but distorted, the o�set value is too high:

In either case, you will need to adjust the Blade O�set value in LXi Production Manager (see Section 2.5) or 

in Create Space (see FIG. 2.6.1). These are the base settings for each type of Muse blade:

30° yellow capped: 0.75 mm (0.03 in)

45° red capped: 0.3 mm (0.01 in)

60° blue capped: 0.4 mm (0.02 in)

 Overcut2.2.3

Correct O�set Too Low Too High

If your test cut has gaps in the paths or if the corners were not cut precisely, you may need to adjust the Overcut 

setting. This can be done on the Default Job Properties tab in the LXi Production Manager (see Section 2.5) or in 

the Cut Settings window in Create Space (FIG. 2.6.1).

Presets allow you to save your settings for a material. The Muse can save up to 8 presets. The pre-loaded presets 

are for EnduraGloss, Holographic and Oracal 651 vinyl, EnduraLITE re�ective sheeting, and EasyWeed, Logical 

Color Warm Peel Universal, HotMark 70, and Logical Color GlitterSoft heat transfer �lm (HTV). Remember, these 

are just pre-loaded for your convenience and are intended to help you get started cutting our most popular 

self-adhesive �lms quickly and correctly. You can change these settings and/or replace them with your own 

presets.

Open an existing PRESET by pressing the LOAD button on the SPD/FOR screen (refer to FIG. 2.2.1). The eight 

presets are split between two screens:

2.3 Presets

Fig. 2.3.1

Fig. 2.2.4



Press one of the Preset boxes and it will turn blue. You then have the option to RENAME it or LOAD it:

 Saving a Cutting Parameters Preset2.3.1

The following steps show you how to create your own preset of cut settings:

1.

2.

3.

From the Main Screen, press the SPD/FOR button.

Enter the desired US, VS, and FS settings and press SAVE (refer to FIG. 2.2.1). The Preset screen will open.

4. Now your new PRESET will appear with the rest of the presets in the menu.

Press one of the custom preset boxes, as shown in 

FIG.2.3.2. Instead of turning blue, it will turn red. 

You can either click on SAVE and that preset will 

be updated with the new settings or you can press 

RENAME and the following keypad will appear. 

Enter the name of the new preset you would like 

to save and press OK (Note: there is a 15-character 

limit).

2.4 Setting the Origin before Cutting

Setting an origin point is an important part of managing your material cost and using the Muse contour 

cutting capabilities. Setting the origin point consists of using the arrow keys to move the tool carriage to a 

speci�c point on the cutter’s X axis (left-to-right on the platen) and advance the media forwards or backwards.

Once you have positioned the blade in a speci�c point over the media (typically close to the bottom right 

corner of the material), your origin is de�ned and you do not need to press anything before cutting.

Fig. 2.3.3

Fig. 2.3.2



To change the Blade O�set covered in Section 2.2.2, click on Properties and select the Cut tab . Enable 

the setting called Knife O�set and enter a new setting, using inches as the units.

NOTE: If you have activated the SHOW POINT option, you can press the middle button after setting a new 

origin point and the x and y values at that position will update to 0,0. As you move the tool carriage away from 

this origin point, the x and y values will show exactly how far away from this new origin point the tool carriage 

has moved. More details on the SHOW POINT option are covered in Section 1.8.3.

2.5 Cutting from Vinyl Express LXi 19 to the Muse

When you are ready to cut, click the Cut/Plot icon 

to launch the Production Manager and open the 

following Cut/Plot window:

For a simple cut you only need to address the 

following on the General tab:

While there are quite a number of other cutting features you may need for your applications, take note of 

several common ones:

Calibrate the camera for contour cutting (refer to Section 3.1).

When you are ready to set an origin, press SET>CAMERA>SCAN>OK.

A photo will be taken. In that photo, press the corner of the reg mark or whatever other indicator you 

are using for an origin. This will move the red “+” to that position.

Again, press OK. For a contour cut, that should be close enough for the camera to �nd the �rst 

registration mark. However, if you need a very precise origin, such as for engraving a charm, continue 

the steps until the dashed lines are dead center with your indicator.

Make sure the correct cutter is selected at 

the top of the Cut/Plot window.

Verify the Material sizing is correct. If not, 

you can click on Properties, enter new 

dimensions and they will appear in the 

drop-down menu for Material.

Check the Preview to make sure it seems 

correct.

Make sure Send mode is set to Send now if you are cutting directly to the Muse immediately.

Fig. 2.5.1

You can also use the Muse’s camera to set a very precise origin for applications such as when engraving metal 

charms or for the placement of the blade holder over the �rst registration mark in contour cutting:



2.6 Cutting from Create Space to the Muse

When you are ready to cut, click on the Cutter 

icon to open the Cut Settings window:

Cut Mode controls where shapes will cut on the 

material. Typically, you will choose Origin Point to 

be more e�cient with material. Shapes will be 

aligned and cut next to the origin you set on the 

material. If the Cut Mode is set to WYSIWYG, 

shapes will cut based on their placement in the 

document (mat) area as shown in FIG. 2.6.2 and 

2.6.3.

Use Software Speed and Pressure: Enabling this 

option will use the Pressure and Speed settings in 

SCAL, thus overriding those set on the Muse’s 

control panel.

When you are ready to send the project to the Muse, click on Send.

To the right of the General tab is the Options tab , where you can set Passes if your material cuts better 

with more than pass.

Also to the right of the General tab is the Advanced tab , where you can modify the Overcut setting 

covered in Section 2.2.3.

Note that when designing in Create Space, you can use either Portrait mode (typically used with the included 

cutting mat) or Landscape mode (typically used for longer projects). These are set on the Document Panel to 

the right, along with setting up your document area under Mat Size. Keep in mind that the triangle (arrow) on 

the edge of the on screen can be used to indicate where your shapes will cut relative to the direction the 

material is fed into the Muse. You can also then verify, based on the preview in the Cut Settings window where 

the shapes will cut relative to the Muse itself:

As you can see in FIG. 2.6.1, there are other cutting functions available in this window, such as Cut Order, Cut by 

Color, Layers (Cut by Layer), Mirroring, and more.

When you are ready to send the project to the Muse, click on Cut.

Fig. 2.6.2 Fig. 2.6.3Fig. 2.6.2

Fig. 2.6.1



2.7 Resolution/Scale Calibration

If you were to cut out any particular shape, for example, a 10” x 10” square, you might �nd that it actually 

measures 9-15/16” x 10-1/32”. It will be very close to 10” x 10” but perhaps just slightly smaller or larger in 

either or both dimensions. Now this might be perfectly acceptable for the type of cutting you do. Therefore, 

it may not even be necessary to do this particular calibration. However, if you do want to make sure your 

shapes are cut precisely to scale, the following procedure will allow you to calibrate your Muse cutter.

Using the test pen and a large sheet of paper, draw the square, noting which side was drawn left-to-right 

(which is the X side) and which side was drawing front to back (which is the Y side), as you face the Muse 

head on.

To calculate the SCALE, divide the design dimension by the actual drawn dimension times the current 

SCALE. Thus, if you draw a 10” square and it measures ~10 1/32” (left-to-right) or if you draw a 250 mm 

square and it measures ~ 250.8 mm (left-to-right), then:

Repeat the test to verify the dimensions are correct. If you still need to adjust, repeat the calculation with the 

newly measured dimensions but remember to also multiply by the SCALE numbers you entered into the 

SCALE screen. Then enter those new SCALE values and test again.

X SCALE = 10” ÷ 10 1/32” x 1= 10” ÷ 10.03” x 1 = 0.997

Or, in metric, X SCALE = 250 mm ÷ 250.8 mm x 1 = 0.997

Repeat for Y SCALE. In this example, assume the Y side 

drew smaller than 10” and the calculated Y SCALE is 

1.002.

Return to the SCALE screen and enter the values using 

the + and – buttons:

In your design software, add a 

square and size it to 10” x 10” 

or, if using metric units, 250 

mm x 250 mm.

On the Muse control panel, go 

to SET>ADVANCED 

SETTINGS>SCALE. The 

following window opens 

where you can verify that the 

current X and Y SCALE values 

are both set to 1.0000:

Fig. 2.7.2

Fig. 2.7.1



Print and Cut (Contour Cut)

3.0 Contour Cutting with your Muse

The Muse uses a combination of hardware, �rmware, and software to enable easy contour cutting of digitally 

printed images.

Contour cutting is a process where an image is sent to a printer with registration marks added around the 

image. The printout is then placed in the vinyl cutter and the vinyl cutter’s camera scans the registration marks. 

It then knows where to cut the contour path around the printed image, based on where the registration marks 

are located relative to the project in the software you’re using.

This chapter covers the calibration of the camera and an overview of the process. For more detailed 

instructions, including video tutorials, go to the SIGNWarehouse Tech Support blog at:

http://techsupport.signwarehouse.com/

3

3.1 Camera Calibration

Your Muse is unlike other cutters. Most contour-cutting vinyl cutters use a laser scanner to scan printed 

registration marks. The Muse has an advanced camera that provides fast and consistent scanning and supports 

very precise calibration.

If you �nd that alignment of the cut path and the intended contour is not ideal, you can bring them into 

alignment by calibrating the camera. Under normal circumstances, the camera alignment should only be done 

once, but if your cutter is jostled or damaged in transit, you may need to recalibrate the camera.

What you need for calibrating:

Use the test pen and a function on the control panel to draw a pattern of vertical and horizontal lines on 

a sheet of paper.

1.

2.

A sheet of white copy paper

Muse test pen (see item #9 in Section 1.4)

The camera calibration process is quite simple. Here’s a brief summary. Step-by-step instructions will follow.

NOTE: If you own a Muse 60 model and plan to use both cutting heads, the calibration for both can be done 

at the same time. Refer to Section 4.1.



The camera will then take a photo of this pattern and the display will show the plotted image with a 

small red cross and long dotted blue lines superimposed.

Tap the middle of the pattern with your �nger to move the small red cross close to the center. You can 

use the arrow keys, if you like, to place it more precisely in the middle. The x3 button on the control 

panel enables magnifying the camera view for extremely precise alignment.

The Muse will take over and locate the center precisely. You will then conclude the calibration by 

pressing STOP on the MAIN SCREEN.

 Step-by-Step Calibration Process3.1.1

The following steps show you how to create your own preset of cut settings:

1.

2.

3.

4.

5.

6.

7.

8.

9.

Load the sheet of paper into the cutter, taking care to adjust the position of the pinch rollers so that the 

paper is securely placed on the platen.

The recommended SPEED and FORCE settings for the camera calibration are 8 and 30, respectively. This 

will help the pen draw a clear and clean test pattern for the calibration.

Place the test pen into the tool carriage. You can open the lid to gain more room to insert the test pen. 

Make sure you position the pen in the blade holder seat so that it’s low enough to mark the paper when 

lowered, but high enough to clear the paper when the blade holder seat is raised. Use the TEST button to 

draw a test square to make sure the pen is positioned correctly.

Once your small test square is cleanly drawn, move the pen over so that the calibration pattern will not be 

drawn on top of your last test.

From the main screen, press SET>CAMERA.

Press START. The test shape, which is a grid of 6 

lines, will be drawn on the paper and the camera 

will move over the test shape, take a photo, and 

display the photo on the control panel.

If you cannot see the test shape clearly, press the 

LED button once so that it reads LED 50%. You can 

also use the X3 button to zoom in, if needed. Press 

the PIC button to take another photo. You should 

see three items in the photo: the test shape that 

was drawn with the pen, a red +, and the blue 

dashed +:

Select ADJUST to open the screen for calibrating. 

Press START: 

Press and hold the OK button for several seconds 

Fig. 3.1.2

Fig. 3.1.1
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�nger here

Select
Adjust

Press and hold OK Press Start



 Adding a Contour Cut to a Design3.2.1

Design or import the image 

which will be printed.

To add a contour path for cutting, 

select the design and go to 

E�ects>Contour Cut. This will 

open the Contour Cut dialog in 

the Design Central toolbox and a 

contour cut should appear:

10.

11.

Tap your �nger near the middle of the 

drawn test shape on the screen. This will 

move the red + close to that location.

Press OK. A new photo will be taken and 

one of two things will happen:

12. Once the alignment is in place,  press the HOME button and then press STOP on the MAIN SCREEN to save 

the calibration and conclude the process:

This section presents the desktop print-and-cut work�ow which requires LXi Master or Master Plus. If you 

use LXi RIP, please refer to Section 3.3.

The red + is so close to the center that the Muse’s camera will now take over and �nd the true center on 

its own. You will see the red + and the blue dashed + aligned in the center and the arrows (only) will 

return to their blue color. Refer to the left side of the next screenshot.

The red + and the blue dashed + are still not aligned. Refer to the right side of the next screenshot. You 

will need to tap the center again and press OK. Continue, if needed, until the center is identi�ed 

automatically.

3.2 Contour Cutting with Vinyl Express LXi 19

Fig. 3.2.1

Fig. 3.1.4

Fig. 3.1.3
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test shape
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Adjust the O�set based on how large a border you want to create between the edge of the printed image and 

the cut path.

To place the cut path inside the printed area for a ‘full bleed’ decal, select a negative value in the O�set instead 

(e.g. -0.0125). Once you have the setting you want and the preview looks acceptable, press the enter key on 

your keyboard or click the green check mark icon in the Design Central window to apply the settings.

 Adding Registration Marks and Printing3.2.2

1. With the design and its contour selected, go to E�ects>Contour Cut Marks. In this Design Central window, 

the type and sizing of registration marks can be modi�ed. First, select SAi Automatic from the drop-down 

menu and the marks will appear like this:

2. By default, the registration mark settings are far more conservative than needed when using the Muse’s 

camera. In order to make them smaller and move them closer to the design, select Options (as shown in 

the prior screenshot). In this next window, you can change to these smaller settings for the Mark Length 

and the Margin:

3. Click on OK to update the registration marks and then click the green check mark icon to accept:

Fig. 3.2.4

Fig. 3.2.3

Fig. 3.2.2



 Contour Cutting to the Muse3.2.3

1.

2.

Load the printout into the Muse using the same orientation as on the screen in LXi. In the example being 

used, FIG. 3.2.5 shows a Landscape orientation and the printout should also appear the same. This is then 

how the printout would also be loaded. Note that if the material is not backed (e.g. paper or cardstock), the 

Muse’s cutting mat should be used as the carrier.

Try to load the material straight so that the front registration marks are parallel to each other on your Muse ’s 

platen. Move the tool carriage so that the blade is over the lower right registration mark. The blade needs to 

be close to the bottom corner as shown in FIG. 3.2.7

3.

4.

5.

4. Go to File>Print and verify that all 

settings and the Preview appear correct. 

You may need to go to File>Document 

Setup and/or File>Print Setup to make 

changes. Otherwise, the Print window 

should show your project with the 

registration marks. Also, verify that the 

Scale is set to 100% before clicking OK to 

print:

In LXi 12, go to File>Cut Contour. LXi Production Manager 

will open, as well as the following Cut Contour window, 

where you can verify the correct cutter is selected (in case 

you have more than one set up):

Click on Send and the Muse will start to scan the marks and 

automatically perform contour cut.

As the camera scans each registration mark, the LCD 

display will show the mark being scanned. If, for any 

reason, the cutter fails to scan a particular mark, the 

camera display will show how far o�-center the alignment 

is. At that point, you can use the arrow keys to adjust the 

camera to align over the corner of the mark and complete 

the scan (FIG. 3.2.9).

Fig. 3.2.8

Position the blade over the lower right corner of 
the lower right registration mark. Fig. 3.2.7

Fig. 3.2.6

Fig. 3.2.5



1.

2.

3.

Import or design the project. To create a contour cut line use the 

same procedure from Section 3.2.1. In this example the following 

design has a negative contour O�set added:

Click on the RIP and Print icon to open the RIP and Print window, as 

well as Production Manager. You’ll observe the design aligned in the 

lower right corner of the preview. Select the design and move it 

away from the corner. Otherwise, when the camera moves to 

photograph the �rst registration mark, it could send the cutting head 

out of range on the right side of the MUSE:

Note the following in the RIP and Print window:

3.3 Contour Cutting with Vinyl Express LXi RIP Design

The RIP Design license allows use of large format printing (with the drivers for the large format printers 

included) as well as color management tools. The following steps present a typical work�ow:

When the cut job is sent, the 
Muse activates its camera and 
begins scanning the marks. Each 
mark is displayed on the LCD 
control panel in real time as it’s 
scanned.

Fig. 3.2.9

Fig. 3.3.1

Fig. 3.3.2

Fig. 3.3.3



4. Click on the Color Management tab and select the appropriate Output Pro�le:

5. Return to the General tab and select Material size, Job size, and Copies as desired:

6. Click on the Contour tab and con�rm all of the following settings before clicking on Send:

7. Click on Send and the job will be sent 

to the printer. In the Job Production 

window, the Printer queue can be 

accessed to monitor the progress of 

the printing:

Fig. 3.3.4

Fig. 3.3.5

Fig. 3.3.6

Fig. 3.3.7



8.

9.

10.

When removing the printout from the larger format printer, be sure to allow several extra inches above the 

printed registration marks for clearance of the pinch rollers.

1.

2.

3.

Import or design your project in Create Space.

To add a contour cut, select the design and go to E�ects>Shadow Layer (Contour Cut). In the window which 

opens, you will set the shape and size of your contour cut. Mark the box for Print+Cut Outline. Click OK.

NOTE: The Print & Cut Outline option 

automatically sets the Cut Line Type for the design 

to Print+Cut Print. This means it will only print and 

will not cut. It also automatically sets the Cut Line 

Type for the contour to Print+Cut Cut which 

means it will not print and will only cut. Note that 

these assignments can be veri�ed or changed by 

selecting a layer and going to the Style Panel:

Load the printout into the MUSE in the same 

orientation as printed and set the blade tip over 

the lower right registration mark as was shown in 

FIG. 3.2.6 and 3.2.7 in Section 3.2.3.

In the Job Production window, select the MUSE tab 

and the job status should indicate Holding. Select 

the job and click on Send at the top:

3.4 Contour Cutting with Create Space

 Adding a Contour Cut to a Design and Printing3.4.1

Fig. 3.3.8

Fig. 3.4.1

Fig. 3.4.2



4. If you wish to see the print border for the 

currently-selected printer and the registration 

marks, enable Show Print Margins and Show 

Registration Marks, respectively on the 

Document Panel:

5.

6.

7.

8.

By default, the registration mark settings are far 

more conservative than needed when using the 

Muse’s camera. In order to make them smaller 

and move them closer to the design (or to the 

borders of the printout), go to Cutter>Cutter 

Settings. In the upper right corner of this 

window, you can make changes, as appropriate 

for your needs. For example:

Click the Cutter icon at the top to open the Cut Settings window. Click the Print+Cut button.

The Print and Cut window will open. Adjust the cut settings, as needed.

Click Print to open the Print window. By default, the Print Registration Marks should be marked. Click OK to 

print the project.

1. Load the printout into the Muse based on the arrow direction (triangle) shown in the main window of Create 

Space. In the example being used, FIG. 3.4.3 shows a Portrait orientation (also indicated on the Document 

Panel) and the printout should be loaded the same way. Note that if the material is not backed (e.g. paper or 

cardstock), the Muse cutting mat should be used as the carrier.

 Contour Cutting from Create Space to the Muse3.4.2

Fig. 3.4.3

Fig. 3.4.4

Fig. 3.4.5



2. Try to load the material straight so that the front registration marks are parallel to each other on your Muse’s 

platen. Move the tool carriage so that the blade is over the lower right registration mark. The blade needs to 

be close to the bottom corner as shown in FIG. 3.4.6.

3.

4.

5.

Select Next to move to the reading of the 

registration marks. You can use the arrows on 

the box to move the carriage or use the 

arrows on the cutter to move the tool 

carriage into the right spot. You want the 

blade in the bottom corner of the lower right 

registration mark.

Once in the correct spot, click Start Scan and 

your Muse will begin scanning the marks:

Position the blade over the lower right corner of 
the lower right registration mark.

As the camera scans each registration mark, the LCD display will show the mark being scanned. If, for any 

reason, the cutter fails to scan a particular mark, the camera display will show how far o�-center the alignment 

is. At that point, you can use the arrow keys to adjust the camera to align over the corner of the mark and 

complete the scan (FIG. 3.2.9).

When the cut job is sent, 
the Muse activates its 
camera and begins 
scanning the marks. 
Each mark is displayed 
on the LCD control 
panel in real time as it’s 
scanned.

Fig. 3.4.7

Fig. 3.4.8

Fig. 3.4.6

Fig. 3.4.9



Special Applications

4.0 What’s So Special about the M60?

Besides having the ability to cut up to 60” wide, the M60 o�ers the following additional capabilities:

4

4.1 M60 Dual Head Calibration

In Section 3.01, the camera calibration was presented showing how to make sure the blade holder is calibrated 

with the camera. A similar calibration is also needed to make sure the right and left blade holder seats are 

perfectly aligned with one another.

1.

2.

3.

Score and cut projects

Foil and cut projects

Cutting at di�erent depths (such as kiss cutting with one blade 

holder and full cutting with the other)

A maximum of 2000g of cutting force which enables some denser materials to cut more easily (such as 

magnetic sheets, stencil and PET-G craft plastics, basswood, wood veneer, chipboard, matte board, 

denim, wool and felt. Note that with any of these types of materials, more than one pass is typically 

needed.

A second cutting head which can be used for applications like:

These additional applications are the reason the M60 also ships with an embossing/scoring tool and a 

second blade holder.

The M60 model further ships with a 30° blade which is well suited for cutting window tint (refer to 

Section 4.2).

1. On the control panel’s Main Screen, make sure the 

Use Double Head option is selected. If you do not 

see any of these options, click on SET>ADVANCED 

SETTINGS>SYSTEM MODE and select Use Double 

Head. Then, back on the Main Screen, the options 

should now be available:

Fig. 4.1.1

Select LEFT+RIGHT HEAD



2.

3.

4.

5.

6.

7.

8.

9.

Insert a sheet of paper into the M60, either on the cutting mat or directly inserted. Load a test pen into 

both the left and right-side blade holder seats, making sure the pen nib is slightly above the paper.

Select the SPD/FOR function and make sure both sides are set to a suitable FORCE for drawing: ~ 30 – 40.

Make sure both pens are over the paper. On the Main Screen, select SET>CAMERA to open the camera 

menu.

The camera will move over the right-side test 

shape, take a photo, and display the photo on 

the control panel. If you cannot see the test 

shape clearly, press the LED button once so that 

it reads LED 50%. You can also use the X3 button 

to zoom in, if needed. Press the PIC button. You 

should see three items in the photo: the test 

shape that was drawn with the right-side pen, a 

red +, and the blue dashed +:

Press ADJUST to open the screen for 

calibrating. Press START.

Press and hold the OK button for several 

seconds:

Press START. The test shape, which is a grid 

of 6 lines, will be drawn �rst on the right 

side of the paper by the right-side pen. 

Then the same test shape will be drawn by 

the left-side pen about 4 inches to the left 

of the �rst test shape.

Tap your �nger near the middle of the drawn test shape on the screen. This will move the red + close to that 

location:

Press OK. A new photo will be taken and one of two things will happen:10.

The red + is so close to the center that the Muse will now take over and �nd the true center on its own. 

You will see the red + and the blue dashed + aligned in the center.  Additionally, the camera will now 

move over to the left side test shape and take a photo.

Fig. 4.1.4

Fig. 4.1.3

Fig. 4.1.2

Tap your 
�nger here

Blue dashed +

Red +

Blue dashed + is also much
closer to the middle of the 
test shape

Red + is now much 
closer to the middle 
of the test shape

Select
Adjust

Press StartPress and hold OK



11.

12.

Once the camera has taken a photo on the left side, 

tap the center of the test shape on the screen and 

press OK. The camera will take over and locate the 

center on its own. 

Once the  arrows appear, press the HOME button 

and then press STOP on the Main Screen to save 

the calibration and conclude the process.

The red + and the blue dashed + are still not aligned.  You will need to tap the center again and press OK. 

Continue, as needed, until the center is identi�ed and the camera moves to the left side test shape and 

takes a photo.

4.2 Setting Up Dual Head Applications on the M60

The M60 comes with a creasing tool (refer to Section 1.4) which can be used to score fold lines. Having the 

second blade holder seat enables you to score and cut all in one process.

In general, the creasing tool works better if multiple passes are used at a moderate pressure versus using a 

single pass at a very high pressure.

The following section shows how to set up a score and cut project in Create Space. Note that a similar setup is 

used when utilizing both blade holders at once versus the creaser and a blade holder.

 Score and Cut Project in Create Space1.6.2

When a project involves both scoring and contour cutting, the layers need to be assigned appropriately on the 

Layers Panel. There should be at least 2 layers: one for the fold lines, and a second for the cut lines.

Decide which head will have which tool mounted. In this example, the left will have the blade holder and the 

right will have the creasing tool (but the opposite is �ne, if you prefer).

Fig. 4.2.1

Fig. 4.1.5

Everything is 
aligned with 
the center

Press Home



4.3 Window Tint with MUSE M60

Select one layer at a time and, on the Style Panel, change settings in the following way:

With the layers properly assigned, the project can now be sent to the Cut Settings window. Make sure Cut 

Mode is set to WYSIWYG. (If left at Origin Point, the score lines will not align properly with the cut lines.)

Under Tool, select 1(L) and enter the 

settings for cutting the cut lines. Verify the 

cut lines appear in the Preview:

Change Tool to 2(R) and enter the settings 

for scoring the fold lines. Disable the option 

for Prompt for pen color change:

Before cutting, verify the M60 is set up for 

Dual head use. Mount the tools, load the 

material, set the origin based on the left 

side tool. Perform any necessary test cuts.

Click on Cut in the Cut Settings window and 

the scoring and cutting will occur in one 

process.

Normal Window Tint Film using a MUSE 30-degree blade and the Muse Blade Holder

The Force should be low; ideal would be between 5-8 on the sliding scale. The blade should be adjusted only 

as deep as the �lm to be cut. Aim for the lower number when using a new and serviceable blade and make 

adjustments as the blade dulls.

For the Speed, on the sliding scale, 3-5 is ideal. Aim for the lower speed as recommended by the manufacturer.

Score Lines: Set Cut Line Type to Draw and set Tool to 2(R)

Cut Layer: Set Cut Line Type to Cut and set Tool to 1(L)

NOTE: All suggested settings are a starting point, depending on the media adjustments that may be 
required based on the media itself.

Fig. 4.2.4

Fig. 4.2.3

Fig. 4.2.2



Because tint is thin and the end-user will be cutting larger shapes. The slower speed and lower force will help 

the tint avoid getting caught in the cutter and getting wrinkled.

4.4 Paint Protection Film with MUSE M60

Normal Paint Protection Film using a MUSE 60-degree blade and the Muse Blade Holder

Paint Protection Film is a PVC �lm with a thickness of 6 mil, although some kinds are 9 or 12 mil thick, 

depending on the brand.

This material is meant for medium-term paint protection of automotive fenders, rear bumpers, and deck or 

side skirts. Because of the thickness of this �lm, a 60-degree blade is recommended.

The blade exposure should be adjusted so that it will only cut as deep as the �lm. Please use the box test 

presented in Section 2.1.

The Force will be about 15-20 on the sliding scale. Aim for the lower number when using a new and serviceable 

blade and make adjustments as the blade dulls. The pressure could vary depending on the blade holder as 

well.

For the Speed on the sliding scale, use the normal speed of 6-7. Since the vinyl is thicker, the Overcut should be 

turned on as well. The ideal Overcut is about .3-in to .5-in (0.75-cm to 1.25-cm).

4.5 Scribe Engraving with MUSE M24

Scribe Engraving using a MUSE Scribe Engraver

When you place the scribe tool into the tool carriage, line up the second line of the tool with the top of the 

arm.

You will need to increase Force and slow down the tool carriage, as well as use the ability to send multi passes. 

That will help with a smooth engraving. Force can be around 20-40 and Speed for US and VS can be around 5 - 

8.

The material for scribing is a little thicker than sign vinyl. This will be great for using the pressure levers for the 

pinch rollers.

NOTE: All suggested settings are a starting point, depending on the media adjustments that may be 
required based on the media itself.

NOTE: All suggested settings are a starting point, depending on the media adjustments that may be 
required based on the media itself.z



Troubleshooting FAQ

Question:   What's the smallest character I can cut?

The Muse cutters use micro-stepper motors which have mechanical gears to move the grit roller 

and cutting head. The mechanical drive limits the precision with which extremely small characters 

can be cut. Letters smaller than .05" will be distorted. A 60° blade may be required for accurately 

cutting small text. When cutting graphics this small, the speed setting on your cutter should be 

reduced.

5

Having trouble? Check out these common questions & answers!

Answer: 

Question:   Why is the cut quality inconsistent?

Inconsistent cut quality is often a function of the speed setting. You can adjust the speed across a 

wide range up to 24 inches per second. High speed is appropriate for large simple shapes and 

letters. But for small fonts and complex shapes, a slower cutting speed will produce better quality.

Answer: 

Question:   Why are there rough edges on cut graphics?

1. The knife blade may be protruding too far from the blade holder. Refer to Section 2.01 and 

   adjust the blade so that you're not cutting too deeply into or through the release liner.

2. Your blade is damaged or worn out and needs to be replaced.

Answer: 

Question:   Why doesn't the vinyl track correctly on long cut jobs?

Poor tracking is typically caused by the vinyl being incorrectly loaded into your cutter. Whenever 

possible, position the pinch rollers as close as possible to the edges of the vinyl. Allow some 

margin for error so that the vinyl doesn't 'walk' out from under one of the pinch rollers as the roll is 

fed through the cutter. 

After loading the vinyl and setting the pinch rollers, use the arrow keys to feed the vinyl forward 

and backward a few feet to ensure the media is loaded properly and tracking straight. Feeding it 

forward and back will also place small grooves in the face �lm that aid in consistent tracking. If the 

vinyl alignment skews consistently to one side during cutting or media feed, there may be uneven 

pressure from the pinch rollers. Check to make sure both, or all pinch roller wheels are in the down 

position. If all wheels are down and the vinyl still consistently skews to one side, you may need to 

replace one of the pinch rollers.

Answer: 



Question:   My LCD display doesn’t seem to turn on - or I see a black row of blocks in my LCD screen

1. If the LCD is blank, check to make sure your cutter is plugged into a working outlet and 

   turned on. 

2. If you’re seeing black blocks on the LCD screen, make sure you're getting adequate 

    voltage to your cutter (your outlet may be lower voltage). If you’re plugged into a 110v 

    outlet, and the problem persists, contact SIGNWarehouse Product support.

Answer: 

Question:   Why are some of the letters cut incompletely?

1. Make sure the blade holder is correctly installed in the tool carriage.

2. Check the blade tip to make sure it isn’t damaged.

3. The blade holder may be worn out. As blade holders age, their control of the blade’s 

    movement is degraded. The �rst sign of this is often incompletely cut shapes, such as 

    rectangles with uncut corners.

4. Reinstall the software and check with your IT support sta� to ensure there is no 

    interference between your computer and your cutter. Anti-virus software can sometimes 

    cause interference in the communication to your vinyl cutter, for instance.

5. If the problem persists, contact SIGNWarehouse Product support.

Answer: 

Question:   Why does my cutter cut more deeply in one part of the vinyl than another?

There is a Te�on strip that covers the width of your cutter under the path of the cutting head 

along the X axis (left to right). When your vinyl cutter is properly set up and cutting vinyl at the 

proper depth, the blade doesn't touch this strip. If the blade is incorrectly installed, or if your cutter 

is allowed to cut beyond the vinyl, the Te�on strip may become scratched. If this happens 

frequently, the strip will become damaged causing that area of the strip to push upward against 

the bottom of the vinyl resulting in inconsistent depth across the platen. Contact SIGNWarehouse 

and purchase a replacement for the Te�on strip.

Answer: 

Question:   Why isn't my Muse responding to jobs sent from the software?

1. This is almost always caused by selecting the wrong port in the setup process. Refer to 

   Section 1.10 and make sure your cutter is in the correct mode for plotting by USB or Wi-Fi. If 

   you're using the USB port, make sure the Port Setting in the LXi Production Manager is 

   USB_Printer_0.

2. If the settings are correct, but your cutter isn't responding, open the LXi Production 

    Manager, change the USB port or connection method, and send a test cut. Repeat until you 

    �nd the correct USB port for the computer. For more detailed instructions, please refer to 

    this article from the SIGNWarehouse Tech Support Blog.

Answer: 



Question:   Why can't I weed the graphics after cutting?

Most likely, you haven't cut the vinyl deeply enough to cut through the face �lm and adhesive. To 

�x this, adjust the pressure setting and perform a test cut. This can be done from the control panel 

or from the LXi Production Manager. Weed the test pattern to make sure the vinyl's face �lm and 

adhesive have been cut, but that the release liner isn't scored too deeply. Adjust the pressure 

setting as needed. Then proceed with your vinyl graphics.

Answer: 

Question:   What kind of maintenance does my Muse cutter need?

All Muse plotters are made with high-quality internal lubrication to protect all mechanical 

components. Therefore, there is no need to oil or lubricate any of the components, ever! Daily care 

consists of cleaning the platen and blade holder to prevent buildup of dust and vinyl debris. 

Dusting the platen with a soft brush will get the job done perfectly. Vinyl debris in the blade 

holder can be removed using a can of compressed air and a nozzle.

Answer: 

3. Check the settings in your LXi Production Manager and make sure the send mode window 

    is set to Send Now (Fig 5.8). If the setting is File or Hold in List, the data won’t be sent from 

    your computer to the vinyl cutter. If it is set to Hold in List, you will �nd the jobs holding in 

    the cutter queue. Click on the job in the queue and use the File/Cut Plot command or click 

    the Send icon.

Fig. 5.8


